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Introduction to the manual

What this chapter contains
This chapter describes the applicability, compatibility, intended audience and the
contents of this manual.

1
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Applicability
This manual applies to the following control panel types and versions:

ACH-AP-WACH-AP-HACS-AP-WACS-AP-I and
ACS-AP-S

Control panel
type

A or laterC or laterA or laterC or laterHardwareversion

5.40 or later5.00 or later5.01 or later4.61 or laterSoftware version

You can view control panel information with either of the two methods:

•
With the drive not powered, press and hold the (? ) button, then power up the
drive and the control panel.

Control panel
Product type:  ACS-AP-I
HW version:  D
FW version:    GPAPI v5.80

or

• With the control panel poweredup, go toMenu→System info→Control panel.

Note: The images and instructions in this manual are examples, each based on a
specific control panel and drive type combination. The details may vary with
different control panels or drive types.
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Compatibility
The table below shows the drive types that are compatible with the following
assistant control panel types.

ACH-AP-H,
ACH-AP-W

ACS-AP-WACS-AP-SACS-AP-IControlpanel
type

ACH180, ACH480,
ACH531, ACQ531,
ACH580, ACQ580

ACS180, ACS280,
ACS380, ACS480,
ACS530, ACS560,
ACS580, ACH480,
ACH580,ACQ580,
ACS860, ACS880,
ACS580 MV,
ACQ80

ACS180, ACS280,
ACS380, ACS480,
ACS530, ACS560,
ACS580, ACQ80

ACS180, ACS280,
ACS380, ACS480,
ACS530, ACS560,
ACS580, ACH480,
ACH580,ACQ580,
ACS860, ACS880,
ACQ80

Drive

Note: The tablemay not be comprehensive. Refer to the appropriate drivemanual
for more details.

Safety
Follow all safety instructions of the drive.

Intended audience
This manual is intended for persons who use the ACS-AP-I, ACS-AP-S, ACS-AP-W,
ACH-AP-H or ACH-AP-W assistant control panel types.

Related manuals

Code (English)Tool and maintenance manuals

3AUA0000094606DriveComposerStart-upandmaintenancePC tool user's
manual

Option manuals and guides

3AUA0000085685ACS-AP-I, -S, -W and ACH-AP-H, -W Assistant control
panels User’s manual

3AXD50000009929CDPI-01 communication adapter module User’s manual

3AUA0000100140DPMP-01 mounting platform for ACP-AP control panel

3AUA0000136205DPMP-02/03 mounting platform for ACP-AP control
panel

You can find manuals on the Internet. For more documentation, go to
www.abb.com/drives/documents.
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Installation and start-up

What this chapter contains
This chapter describes how to install and start-up the assistant control panel for
the first time.

2
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Installation
Attach the control panel directly to the drive or use a separate mounting kit (for
example, for cabinet door mounting).

To attach the control panel,

1. Put its bottom end into the bottom of the slot in the drive (A).

2. Pivot the control panel and push the upper part (B) until you hear a click.

To remove the control panel,

1. Press the clip (B) to release the control panel.

2. Pull the upper end of the control panel out of the slot in the drive.

B

A
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First start-up
To start-up the control panel for the first time, follow the instructions:

1. Obey all drive-specific safety precautions.

2. Install the control panel. Refer to Installation (page 16).

3. Power up the drive.
The control panel start-up begins automatically. Wait until the control panel
shows the language selection view.

4. Use or to select a language.

5. Press to confirm your selection.
Wait until the control panel completesuploading the language file. Theprogress
is indicated by a progress bar.

If there is a Basic set-up assistant in the drive, or if the control panel already
contains a compatible backup (or backups) that could be copied to the drive, the
control panel shows a question.
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Once you are in the Home view, the control panel is ready for use.
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Control panel overview

What this chapter contains
This chapter describes the display, keys and main parts of the assistant control
panel.

3
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Display, keys and parts

1
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USB connector10Display1

Clip11Left softkey2

RJ45 connector12Right softkey3

Type code label on the control panel13Status LED4

Battery cover14Help5

Off15Arrow keys6

Hand16Stop (refer to Start and Stop (page 24)).7

Auto17Start (refer to Start and Stop (page 24)).8
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Local/Remote (refer to
Loc/Rem (page 25)).

9
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￭ Display

In most views, the display shows these elements:

1

7

6

2 3 4 5

8 7

Shows how the drive is controlled:Control location
and related icons

1

No text: The drive is in local control, but controlled from another
device. The icons in the top pane show the permitted actions.

Local: The drive is in local control, that is, controlled from the control
panel.

Remote: The drive is in remote control, that is, controlled through
I/O or fieldbus.

Shows that there are more than one drive connected to this control
panel. To switch to another drive, go to Options→ Select drive.

Panel bus2
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Shows the status of the drive and the motor. The direction of the
arrow shows forward (clockwise) or reverse (counter-clockwise)
active reference direction.

Status icon3

Note: For non-rotating driven equipment, the numbers 1 and 0 are
used to show that the drive is running or stopped, respectively.

Drive statusAnima-
tion

Status
icon

Stopped-

Stopped, start inhibited-

Stopped, start commandgivenbut start inhib-
ited

Blinking

FaultedBlinking

Running, at reference, but the reference value
is 0

Blinking

Running, not at referenceRotating

Running, at referenceRotating

Pre-heating (motor heating) active-

PID sleep mode active-

If a name is given, it is shown at the top pane. By default, it is blank.

You can change the name in the Primary settings (page 57) or
Settings (page 56) menu.

Drive name4

Speed, frequency and soon, are shownwith its unit. For information
on changing the reference value, refer toSetting the refer-
ence (page 62).

Reference value5

Shows the actual content of the view in this area. The content varies
from view to view. The example shows the Home view which is the
primary view.

Content area6

Shows the functions of the softkeys ( and ) in a given context.Softkey selec-
tions

7

Shows the current time. The time can be changed through the

Primary settings (page 57) or Settings (page 56) menu.

Clock8
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You can adjust the display contrast and backlight functionality in the Primary
settings (page 57) or Settings (page 56) menu.

￭ Keys

The keys of the control panel are described below.

Left softkey

The left softkey ( ) primarily exits views or cancels actions. The bottom left
corner of the display shows the current function of the key.

Hold down to exit each view in turn until you are back in the Home view. This
function does not work in special screens.

Right softkey

The right softkey ( ) primarily selects, accepts or confirms values or actions.
The bottom right corner of the display shows the current function of the key.

Arrow keys

Use the up and down arrow keys ( and ) to highlight selections in menus and
selection lists, to scroll up and down on text pages, and to adjust values when, for
example, setting the time, entering a passcode or changing a parameter value.

Use the left and right arrow keys ( and ) to move the cursor left and right in
parameter editing and to move forward and backward in assistants. In menus,
and function the same way as and , respectively.

Help

The help key (? ) opens a help page. The help page is context-sensitive, in other
words, the content of the page is relevant to the menu or view in question. Refer
to Help (page 34) for more information on the help page.

Start and Stop

In local control, the start key ( ) and the stop key ( ) start and stop the drive,
respectively.
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Off

In Hand and Auto control, the Off key ( ) is used to stop the drive.

Hand

The Hand key ( ) starts the drive in local mode. When the drive is running, if you
switch to Automode, the drive changes the control location to Remotemode and
the drive may stop.

Auto

The Auto key ( ) sets the drive in automaticmode. The control is selected from
primaryor secondaryor anyDI. You cangive the reference inputs inMenu→Primary
settings → Drive or by setting the values in parameter groups 19 and 20.

Loc/Rem

The location key ( ) switches the control between the control panel (Local) and
remote connections (Remote). When switching from Remote to Local while the
drive is running, the drive keeps the same speed. When you change from Local to
Remote, the status of the remote location is adopted. Refer to the drive-specific
firmware manual for more details.

Key shortcuts

The table below lists key shortcuts and combinations. The plus sign (+) refers to
simultaneous actions.

EffectAvailable in...Shortcut

Save a screenshot. Up to fifteen images can be stored
in the control panel memory. For instructions on how
to transfer the images into a PC, refer to section
Transferring files between the control panel and a PC.

any view+ +

Adjust backlight brightness.any view+

+
Adjust display contrast.any view+

+
Adjust reference.Home viewor

Revert an editable parameter to its default value.parameter edit
views

+

Show/hide parameter index and parameter group
numbers.

any view+

Return to Home view by pressing down the key until
Home view is shown.

any view

(keep down)
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￭ Control panel and panel platform/holder LEDs

TheACS-AP-…control panel has a status LED. The control panelmountingplatform
or holder has two status LEDs. For status LED indications, see the following table.

IndicationLEDLocation

The unit operates normally.Continuous
green

Control panel

Data is transferred between the PC and the unit
through the USB connection of the control panel.

Flickering green

There is an active warning in the unit.Flashing green

There is an active fault in the unit.Continuous red

There is a fault that requires the stopping and restart-
ing of the drive/converter/inverter.

Flashing red

The Bluetooth interface is enabled, in discoverable
mode, and ready for pairing.

Flashing blue
(ACS-AP-W only)

Data is transferred through the Bluetooth interface
of the control panel.

Flickering blue
(ACS-AP-W only)

There is an active fault in the unit.RedControl panel
mounting
platform or
holder (with the
control panel
removed)

Power supply for the control unit is OK.Green

￭ USB connector

The USB connector is used to connect the control panel to a PC. When it is
connected, the control panel acts as an USB adapter for data transfer between
the Drive Composer PC tool and the drive. It is also possible to transfer data
between the PC and the control panel through the USB connection.

Refer to External connections (page 79).
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￭ Wireless interface

The ACS-AP-W and ACH-AP-W assistant control panels with a Bluetooth interface
enable wireless communication for ABB drives. The wireless panels are also
embedded with powerful processor and memory that enables faster
communication.

For other control panel functions

• ACS-AP-W control panels are the same as ACS-AP-I and ACS-AP-S panels, and

• ACH-AP-W control panels are the same as ACH-AP-H control panels.

Refer to Bluetooth connection.

WARNING! Do not use this device within a 20 km radius of the centre of
Ny-Ålesund at Svalbard, Norway.

￭ RJ45 connector

TheRJ45 connector connects the control panel to thedrive.Mechanical connection
is achieved with the clip on the top.

￭ Type code label on the control panel

The type code label on the control panel contains revision information. See an
example label below.

Type code label on ACS-AP-I, ACS-AP-S, ACH-AP-H and ACS-BP-S panels

Figure 2 Example of type code label for ACS-AP-W, ACH-AP-W 

1.2 Label layout: Package label 

Figure 3 Example of Panel package label (ACS-AP-I, ACS-AP-S, ACH-AP-H, ACS-BP-S, 
ACS-AP-W, ACH-AP-W).  

First row ACS-AP-I   ABB Oy  
Made in Country 

IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII 
3AXD50000025965A0210001LL 
 

EAN code 

IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII 
6438177379744                    SW:v5.95 

Second row 

Third row 

Fourth row 

Fifth row 

Sixth row 

Seventh row 

ABB Oy, Hiomotie 13, 00380 Helsinki, Finland  Made in Country 

M/N: ACS-AP-W CODE: 3AXD50000025964 S/N: B1250121LL 

CMIIT ID: 2022DJ0727  ANATEL: 10784-23-02705  SW: vX.XX

FCC ID: 2AFNGAPWSERIES  IC: 20555-APWSERIE        R-R-Abb-ControlPanel

First row 

 ABB Oy, Hiomotie 13, 00380 Helsinki, Finland      
 M/N: ACS-AP-I  CODE: 3AUA0000064885  S/N: B1250121LL 

 3AUA0000064885B1250121LL    Made in Country 

   SW: vX.XX    

Second row 

Third row 

Fourth row 

Fifth row 

1

2

8

7

3 4

5

66

9

ABB Oy1

Type code2

MRP code3

Serial number4
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CN RoHS, CE, and UKCA markings5

SW version6

Bar code7

Bar code in readable text8

Manufactured in country9

Type code label on ACS-AP-W and ACH-AP-W panels

1.1 Label layout: Control panel label  

Example of panel label is shown in 
Figure 1: ACS-AP-I, ACS-AP-S, ACH-AP-H, ACS-BP-S.  
Figure 2: ACS-AP-W, ACH-AP-W. 

Figure 1 Example of type code label for ACS-AP-I, ACS-AP-S, ACH-AP-H, ACS-BP-S. 

1.2 Label layout: Package label 

Figure 3 Example of Panel package label (ACS-AP-I, ACS-AP-S, ACH-AP-H, ACS-BP-S, 
ACS-AP-W, ACH-AP-W).  

First row ACS-AP-I   ABB Oy  
Made in Country 

IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII 
3AXD50000025965A0210001LL 
 

EAN code 

IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII 
6438177379744                    SW:v5.95 

Second row 

Third row 

Fourth row 

Fifth row 

Sixth row 

Seventh row 

ABB Oy, Hiomotie 13, 00380 Helsinki, Finland  Made in Country 

M/N: ACS-AP-W CODE: 3AXD50000025964 S/N: B1250121LL 

CMIIT ID: 2022DJ0727  ANATEL: 10784-23-02705  SW: vX.XX  

FCC ID: 2AFNGAPWSERIES  IC: 20555-APWSERIE        R-R-Abb-ControlPanel

CE and UKCA 
See marking 
requirements 

Height min 5mm 

DO NOT
CHANGE 
SYMMETRY OF 
MARKING 

First row 

Second row 

Third row 

Fourth row 

Fifth row 

 ABB Oy, Hiomotie 13, 00380 Helsinki, Finland      
 M/N: ACS-AP-I  CODE: 3AUA0000064885  S/N: B1250121LL

3AUA0000064885B1250121LL    Made in Country 

SW: vX.XX    

CN RoHS 

1

2

9

6

7

6

10 12 13

3 4 5

8

11

ABB Oy1

Type code2

MRP code3

Serial number4

Manufactured in country5

CN RoHS, CE, KC and UKCA markings6

KC number7

Bar code8

CMIIT ID number9

FCC ID number10

ANATEL number11

IC CANADA number12

SW version13

28 Control panel overview



￭ Type code label on the control panel package

The type code label on the control panel package contains revision information.
See an example below.

1.1 Label layout: Control panel label  

Example of panel label is shown in 
Figure 1: ACS-AP-I, ACS-AP-S, ACH-AP-H, ACS-BP-S.  
Figure 2: ACS-AP-W, ACH-AP-W. 

Figure 1 Example of type code label for ACS-AP-I, ACS-AP-S, ACH-AP-H, ACS-BP-S. 

ACS-AP-I   ABB Oy  
Made in Country 

IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII 
3AXD50000025965A0210001LL 
 

EAN code 
IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII 
6438177379744                    SW:v5.95 

ABB Oy, Hiomotie 13, 00380 Helsinki, Finland  Made in Country 
M/N: ACS-AP-W CODE: 3AXD50000025964 S/N: B1250121LL 

CMIIT ID: 2022DJ0727  ANATEL: 10784-23-02705  SW: vX.XX
FCC ID: 2AFNGAPWSERIES  IC: 20555-APWSERIE        R-R-Abb-ControlPanel

CE and UKCA 
See marking 
requirements 

Height min 5mm 

DO NOT
CHANGE 
SYMMETRY OF 
MARKING 

First row 
Second row 

Third row 

Fourth row 
Fifth row 

 ABB Oy, Hiomotie 13, 00380 Helsinki, Finland      
 M/N: ACS-AP-I  CODE: 3AUA0000064885  S/N: B1250121LL

3AUA0000064885B1250121LL    Made in Country 

SW: vX.XX    

CN RoHS 

1

3

5

6

7

8

2

4

9

Type code1

ABB Oy2

Manufactured in country3

CE and UKCA markings4

Bar code5

Bar code in readable text6

EAN bar code7

EAN number code8

SW version9

￭ Battery cover

Underneath the battery cover there is a compartment for the battery that powers
the real-time clock of the control panel.
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Basic operation

What this chapter contains
This chapter describes thebasic operations and components of the user interface.
It also lists the commonuser tasks andprovides instructions to complete the task.

User interface overview
The user interface has these parts:

DescriptionComponent

Used to monitor signals. Refer to Home view (page 33).Home view

Access to most functions of the control panel. Refer to the detailed
description in chapter Functions in the main Menu (page 37).

Menu

Used to set a reference, change themotor direction, select the drive,
edit Home view pages, and see the fault and warning status. Refer
to the detailed description in chapter Functions in the Options
menu (page 61).

Options

Provides information on the current view or menu or on possible
problems associated with it. Refer to Help (page 34).

Help

Shows faults and warnings when the drive or control panel experi-
ences an error. Refer to Fault tracing (page 71).

Faults and warnings

4
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Control panel navigation
Use the arrow keys and softkeys for navigation. Follow the choices on the screen.

Energy efficiency

Parameters

Assistants

Event log

History graphs

Backups

System info

Settings

Reference

Direction change
Select drive

Edit Home view

Active faults
Active warnings

MenuOptions

Note: The menu shown is an example only. The Menu varies based on the
drive/device to which the control panel is connected.

￭ Navigation memory

The assistant control panel has a navigationmemory that allows you to backtrack
your steps through the user interface with the arrow keys and . The path you
last accessed is in the memory for 10 minutes.

• The left arrow key ( ) moves you backwards in the menu structure.
If you press repeatedly, you return back to the Home view.

• The right arrow key ( ) moves you forward in the menu structure.
If you press repeatedly, you move forward along the path in the menu
structure you had previously accessed.
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Home view
The Home view is the primary view of the control panel. In theHome view, you can
monitor the status of thedrive, such as its speed, torqueor power. TheHome view
has one or more pages, each of which can display up to three signals.

The number of pages and the signals shown on each page are customizable, and
the Home view configuration is saved to the drive whenever you change it. The
maximum total number of signals displayed varies from 9 to 21, depending on the
drive. In the examplebelow, there are threeHomeviewpageswithdifferent display
formats.

Each applicationmacro anduser set has a default Home view configuration.When
you select an applicationmacroor restore a user set, theHomeviewconfiguration
changes accordingly. There is a default Home view configuration in each drive,

which canbe restored in the Primary settings (page57) or Settings (page56)
menu.

Note: The Menu varies based on the drive/device to which the control panel is
connected.

The Home view opens automatically when you power up the drive. The control
panel shows the Home view from the Optionsmenu or the mainMenu, if no key
is pressed for 10 minutes.

Tip: To return to the Home view from any view except special screens, hold down
the left softkey .

￭ Navigating in the Home view

• Use and tomove between the different pages of theHome view. The page
numbers are shown while you scroll between pages.

• Use or to adjust the reference (visible in the top right corner). Refer to
Setting the reference (page 62).

• Press (Menu) to open the mainMenu (refer to Functions in the main
Menu (page 37)).

• Press (Options) toopen theOptionsmenu (refer toFunctions in theOptions
menu (page 61)).
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Help

To open a context-sensitive help page in all menus and views, press the ? button.
The help page has information on the use of the current view or menu, or on
possible problems associated with it.

On the help page, you can press the ? button again or press (Exit) to exit.

Note:

•
With the ? button, you can also view details of the control panel type and
version in the panel itself. Refer to instructions in section
Applicability (page 12).

•
With the ? button, you can also connect the control panel to Drivetune via
Bluetooth. Refer to instructions in section Connecting control panel to
Drivetune via Bluetooth.

Common user tasks
The following tables list common user tasks and describe how to complete the
task. Refer to chapters Functions in themainMenu (page 37) and Functions in the
Options menu (page 61) for detailed descriptions of functions in the menus.

Note: The Menu options varies based on the drive/device to which the control
panel is connected.

￭ Basic operation of the drive

ActionsTask

In local control, press to start the drive and to
stop the drive.

Start and stop the drive.

In local control, go to Options > Reference. Set the
reference with the arrow keys. For detailed instruc-
tions, refer to Setting the reference (page 62).

Set the reference (for example,
speed) in the Home view.

Press .Switch between local and remote
control.

In local control, go to Home view, press (Options)
toopen theOptionsmenuandselectDirectionchange.

Change thedirectionofmotor rota-
tion.
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￭ Parameters

ActionsTask

Go toMenu→ Parameters→ Favorites→ Edit. Refer
to also Favorites (page 40).

Choose the parameters displayed
on the Favorites list.

Go toMenu→ Parameters→ Complete list to view
parameters.

Refer to Editing parameters (page 41) for instructions
on editing parameters

View/edit parameters.

Refer to Editing the contents of the Home
view (page 62).

Add parameters to the Home view.

Press + .Show/hide parameter index and
group numbers.

In the editing mode, press + .
To save the default value, press (Save).

Restore thedefaultparameter value.

Go toMenu→ Parameters→Modified.View parameters that differ from
Application Macro defaults.

￭ System information and help

ActionsTask

Press ? button to open the context-sensitive help.How to get help.

Go toMenu→ System info→ Drive.To view drive information.

Go toMenu→ System info→ Control panel.To view control panel version.

Go toMenu→ System info→ Licenses.Toviewapplicationprogram license.

Go toMenu→ System info→ Product application.To viewProduct application inform-
ation.

￭ Faults and warnings

Refer to Fault tracing (page 71) for detailed information on faults and warnings.

ActionsTask

Faults are automatically shown. If youhide a faultwith
(Hide), it automatically reappears after 60 seconds

of no key presses. You can also view the fault through
Options > Active faults.

Hide/view an active fault.

Press ? button to open the help page.Open the help page on a fault.

Press (Reset) to reset an active fault.Reset an active fault.

Go toMenu→ Event log→ Faults.View tripping faults.
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ActionsTask

Warnings are automatically shown. If you hide awarn-
ing with (Hide), it automatically reappears if the
warning is still active after 60 seconds of no key
presses.

Hide/view an active warning.

Press (How to fix) or ? button to open the help
page.

Open the help page on a warning.

Warningsdisappear automaticallywhen thecondition
that has triggered it goes away.

Reset an active warning.

Go toMenu→ Event log→ Other events.View past warnings and faults.

￭ Basic settings and assistants

ActionsTask

Press and hold , and press or .Adjust backlight brightness.

Press and hold , and press or .Adjust display contrast.

Go toMenu→ Settings→ Language.Change the language.

Go toMenu→ Settings→ Date & time.Change the time and date, and re-
lated settings.

Go toMenu→ Assistants and select an assistant to
launch.

Launch an assistant.

￭ Backups

ActionsTask

Refer to Backups (page 50).
Create a backup.

Restore a backup. Refer to Backups (page 50).
Restore a backup.

￭ Bluetooth configurations

ActionsTask

Refer to Connecting control panel to Drivetune via
Bluetooth.

Activate bluetooth (pairing).

Refer to Connecting control panel to Drivetune via
Bluetooth.

Disable Bluetooth.

Press andhold ? button for twosecondson the control
panel to show a PIN.
PressOptionsbuttonon the right corner of the control
panel to select Stay discoverable (no timeout).

Set "Staydiscoverable (no timeout)"
mode.
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Functions in the main Menu

What this chapter contains
This chapter describes the functions in the mainMenu.

5
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Menu
All functions of the control panel are accessed through theMenuwhich is themain
menu of the user interface. This section lists the sub-menus and the sections that
follow describe them in detail.

The sub-menus varies based on the drive/device to which the control panel is
connected:

Refer to
page…

FunctionSub-menu

39View and edit parameters.Parameters

45Launch an assistant.Assistants

48Use energy-saving features.Energy efficiency

48View information on faults and warnings.Event log

48View the load profile.History graphs

50Save settings in the control panelmemory and restore
them to the drive.

Backups

52View information on the drive and options.System info

56Set time and date settings, language, display and
other settings, and edit texts.

Settings

57Set settings related tomotor, PID, fieldbus, advanced
functions, clock, region, and display.

Primary settings

59Shows the terminal name, number, electrical status
and logical meaning of the drive.

I/O

60Shows the faults and warnings information and helps
to resolve potential problems.

Diagnostics
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￭ Navigating in the Menu

• Use and to select a menu item.

• Use or (Exit) to go back to the Home view.

• Use or (Select) to the open the selected sub-menu.

Parameters
In the Parametersmenu, you can view and edit parameters. There are four
sub-menus to access the parameters. In each sub-menu, the grouping principle
of the parameters is different.

In each sub-menu, to edit a parameter, highlight it and you can edit a parameter
by highlighting it andpressing (Edit). Counter parameters and certain number,
text and bit field parameters are read-only and can be viewed by pressing
(View).

￭ Complete list

In theComplete list sub-menu, all parameter groups are listed in numerical order.
Select a parameter group to see and edit all of the parameters in the group.

This sub-menu shows the parameter numbers.

￭ By function

This functionality is available in a future release.
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￭ Favorites

The Favorites sub-menu shows only user-selected parameters. The parameter
number determines the order of the list.

Editing the list of favorites

1. Select Edit.

2. To select parameters for the list of favourites, highlight the parameter and
press (Select).

3. Press (Done) to exit and save changes.

￭ Modified

TheModified sub-menu shows only the parameters whose values differ from the
Application Macro defaults. The order is determined by the parameter number.

￭ Adding parameters to the Home view

When you view a read-only parameter in the Parametersmenu, you can add the
parameter to the Home view.
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• Press (Add to view) to open the Home view in the editingmode to add the
parameter to an empty display slot or replace an existing parameter.

• Press (Back) to go back to the parameter view.

Editing theHome view functions aredescribed in Editing the contents of theHome
view (page 62).

￭ Editing parameters

You can edit parameter values with the arrow keys.

1. Press (Select) to select the desired parameter from the list.

2. Press (Edit).

3. Use and to change the value.

4. Press (Save) to save the value, or press (Cancel) to exit the parameter
view and discard any changes.

5. Press + to restore the default value of the parameter (this does not save
it).

See the sections below formore information on editing specific parameter types.

￭ Editing numeric parameters

Numeric parameters include parameters with linear numeric values, passcodes,
timeanddateparameters, durations andexceptiondates. For numeric parameters
with linear values, the minimum and maximum values are shown in the bottom
left and right corners of the content area, respectively.

• Use and to highlight digits

• Use and to change the value.

• Press (Save) to save the value and exit the view.

• To cancel and exit, press (Cancel).
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￭ Editing selection list parameters

A selection list consists of mutually exclusive options, such as the language
selection list.

• Use and to move the cursor.

• Press (Save) to select and save the highlighted option.

• To cancel and exit, press (Cancel).

Someselection list parameters allowyou to choose another parameter as its value.
In addition toapreset list of options, you can select aparameter freely, represented
by the selection Other in the list.

To select a parameter, follow the instructions:

1. Select Other to move to a list of parameter groups.

2. Select a parameter group to move to a list of parameters.
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3. Depending on the parameter, select a parameter or an individual bit.
• If the right softkey label is Select, select an individual bit as the value of

the parameter. Press (Select) to move to a bit selection list.
• If the right softkey label isSave, you can select that parameter as the value

of the parameter. Press (Save) to save the selection.
• If the right softkey label is Save and there is also an arrow on the right

hand side of the selection, you can choose an individual bit or all the bits
in that parameter. Press to move to a bit selection list. If you want to
select all the bits in the parameter, press (Save) instead.

4. Select a bit if applicable (refer to the previous step).
Press to invert the selected bit and press (Save) to save the selection.

The parameter or bit is now selected as the parameter value.
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￭ Editing bit-field parameters

A bit-field parameter is a bit word whose individual bits can be edited. The labels
describe the function of each bit, and the current state of the bit is shown as 1 or
0.

• Use and to select a bit.

• To change a bit value, press or .

• To save the bit values and exit, press (Save).

• To cancel and exit, press (Cancel).

￭ Editing texts

Texts that you can edit with the control panel include parameter display names in
the Home view and their units, drive names, fault and warning names, and other
customizable notes or names.

• To select the character mode (lower case / upper case / numbers / special
characters), press , theunit symbol  is highlightedand thenselect themode
with or .
Now you can start to add characters. The mode remains selected until you
select another one.

• To add a character, highlight it with and then press .
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• To remove a letter, press .

• Press (Save) to accept the new setting, or press (Cancel) to go back to
the previous view without making changes.

Note: The current software version supports only the English character set (a...z).

￭ Resetting counters

Counters are parameters that measure incremental quantities associated with
theuseof thedrive suchas runtimeor energy consumption. Counters are updated
automatically and cannot be edited. To reset a counter to zero, press (Reset)
for three seconds.

Note: If a trigger value is defined for the counter, the counter’s progress fromzero
to the trigger value is shown as a bar graph.

Assistants
In the Assistants menu, you can launch an assistant, which is a sequence of steps
that help you to complete a task, such as setting up the control panel to use with
the drive and the motor, or fixing a fault. You can also generate a QR code, which
is an optical code containing information of the drive. You can read the code with
a mobile device to link to the drive information.

￭ Launching an assistant

1. Use and to highlight the desired assistant.

2. Press (Select).
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3. Follow the instructions on the display to do the selected task:
• Use and to select settings.
• To edit a setting, press (Edit or Select).
• Use or to move between the pages of the assistant. The progress bar

in the upper right corner of the display indicates the progress.
• To exit the assistant, press (Exit).

Most settings accessed in assistant steps can also be accessed through themain
Menuor the Parametersmenu, but the steps the assistants aremore user-friendly.
You can accessmost of the settings in theAssistantsmenualso through theMenu
or Parameters menu. The Assitants can give a more user-friendly experience.

Note: If you use the Assistants menu, complete all steps to save the changes,
otherwise the changes are cancelled.
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￭ Generating a QR code

1. In the Assistants menu, select QR code using and and press (Select).

2. Press (Continue).
The control panel collects data and generates the code.

Press << or >> to go to the next screen.

You can also generate QR code fromMenu→ System info→ QR code. Refer to
System info (page 52).
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Energy efficiency
In the Energy efficiency menu, you can view and configure parameters related to
energy savings, such as kWh counters.

Event log
In the Event logmenu, you can view information collected on faults andwarnings.
Events are automatically logged. Refer to Fault tracing (page 71) for more
information on faults and warnings.

• Faults sub-menu shows the faults that have tripped the drive.

• Other events sub-menu shows all other faults, andwarnings and their details.

• Active faults and Active warnings sub-menu shows the faults and warnings
that are active.

History graphs
The History graphs menu contains the trends and Load profile sub-menus.
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￭ Trends

This functionality is available in a future release.

￭ Load profile

In the Load profile submenu, you can view and configure load profiles.

The menu contains the following sub-menus:

• Motor current logger: Shows thedistribution ofmotor current in a histogram.
This logger cannot be reset.
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History graphs

The History graphs menu contains Trends and 
Load profile sub-menu.

 Trends

This functionality is available in a future release.

 Load profile

In the Load profile submenu, you can view and 
configure load profiles. The menu contains the 
following sub-menus:

• Amplitude logger 1: Opens a Histogram view, 
which displays the motor current as a 
distribution histogram. This logger cannot be 
reset.

• Amplitude logger 2: Opens a Histogram view, 
which displays the contents of an amplitude 
logger as a distribution histogram. You can 
select the signal to be monitored.

• Load profile configuration: Select the signal 
to be monitored in Amplitude logger 2.

• Peak value logger: Select a signal to be 
monitored by a peak value logger.

For more information on load profiles, see the appropriate firmware manual.

Backups

In the Backups menu, you can save parameter 
settings in the control panel memory and restore 
parameter settings from a backup to the drive. You 
can store up to two backup files on the control 
panel.

The assistant panel has a dedicated space for one 
automatic backup. An automatic backup is created 
two hours after the last parameter change. After completing the backup, the panel 
waits for 24 hours before checking if there are additional parameter changes. If there 
are, it creates a new backup overwriting the previous one. 

You can copy backup files to and from a PC with any file manager application 
(example, Windows Explorer).

• Load profile logger: Shows the contents of a load profile logger as a
distribution histogram. You can select the signal to be monitored.
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History graphs

The History graphs menu contains Trends and 
Load profile sub-menu.

 Trends

This functionality is available in a future release.

 Load profile

In the Load profile submenu, you can view and 
configure load profiles. The menu contains the 
following sub-menus:

• Amplitude logger 1: Opens a Histogram view, 
which displays the motor current as a 
distribution histogram. This logger cannot be 
reset.

• Amplitude logger 2: Opens a Histogram view, 
which displays the contents of an amplitude 
logger as a distribution histogram. You can 
select the signal to be monitored.

• Load profile configuration: Select the signal 
to be monitored in Amplitude logger 2.

• Peak value logger: Select a signal to be 
monitored by a peak value logger.

For more information on load profiles, see the appropriate firmware manual.

Backups

In the Backups menu, you can save parameter 
settings in the control panel memory and restore 
parameter settings from a backup to the drive. You 
can store up to two backup files on the control 
panel.

The assistant panel has a dedicated space for one 
automatic backup. An automatic backup is created 
two hours after the last parameter change. After completing the backup, the panel 
waits for 24 hours before checking if there are additional parameter changes. If there 
are, it creates a new backup overwriting the previous one. 

You can copy backup files to and from a PC with any file manager application 
(example, Windows Explorer).

• Load profile configuration: Select the signal to be monitored in Load profile
logger.

• Peak value logger: Select a signal to be monitored by a peak value logger.

For more information on load profiles, refer to the appropriate firmware manual.

Backups
In theBackupsmenu, you can saveparameter settings in the control panelmemory
and restore parameter settings from a backup to the drive. You can store up to
two backup files on the control panel.

The control panel has a dedicated space for one automatic backup. An automatic
backup is created two hours after the last parameter change. After completing
the backup, the control panel waits for 24 hours before it monitors for additional
parameter changes. If there are changes, it creates a new backup that replaces
the previous one.

You can copy backup files to and from a PC with any file manager application (for
example, Windows Explorer).

Some of the Backup icons are listed below:

IconBackup

Automatic backup

Compatible backup
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IconBackup

Incompatible backup

Partly compatible

￭ Creating a parameter backup

1. In the Backupsmenu, select Create backup.

If there is a free backup slot in the control panel, the following step is skipped.

2. Use and to select one of the existing backup files, and press Replace.

3. Wait until the backup is completed. An animation is shownon the control panel
during the backup process. The control panel automatically returns to the
Backupsmenu.

Note: If thebackupprocess is canceledor interrupted, thepreviously savedbackup
file is not deleted or damaged. Thus, if you accidentally start a backup process,
you can safely cancel it before its completion.

￭ Restoring a parameter backup

1. In the Backupsmenu, select the backup file you want to restore.

2. Select View backup contents and check that it is the correct backup file and
that it is suitable for restoring.

Note: This functionality is available in a future release.

3. Select one of the restore options:
• To restore all settings, select Restore all parameters.
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• To restore a set of parameters, select Select par restore group and select
the desired parameters from the list, and then select Restore.

• To select application parameters, select Select application items and
select the desired parameters from the list and then select Restore.

• To select user parameters sets, select Select user sets and select the
desired user set from the list and then select Restore.

• To select production data items, select Select prod. data items and select
the desired production data and then select Restore.

4. Wait until the restore is complete. The control panel display showsananimation
during the restoring process. The control panel automatically returns to the
Backupsmenu.

System info
In the System infomenu, you can view information about the drive, control panel,
fieldbus and any installed option modules. You can also generate a QR code that
contains the drive information.
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FunctionSub-menu

Shows informationon the selected component, suchas firmware version,
serial number, type code, device ID number or date of manufacture.

Drive

Note: The content of the view varies between different drive types.

Shows information on the hardware and software version of the control
panel.

Control panel
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FunctionSub-menu

Shows an optical code containing information of the drive. You can read
the code with a mobile device.

QR code

To generate the QR code, press (Continue).

The control panel collects data and creates the code.
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FunctionSub-menu

Shows the file system usage information and how to remove backup
files, screenshot files, log files, QR codes, old language files and allMedia
Transfer Protocol (MTP) files.

Clean file system

File system usage shows the percentage of used and free space of the
file system.

To remove backup files, press (Continue).

To remove screenshot files, press (Continue).

To remove log files, press (Continue).
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FunctionSub-menu

To remove QR codes, press (Continue).

To remove old language files, press (Continue).

To remove all MTP files, press (Continue).

Settings
The Settings menu has the following sub-menus:

FunctionSub-menu

Select different language in the control panel.Language
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FunctionSub-menu

Set the date and time, and select their display settings and whether the
control panel automatically adjusts the time fordaylight savings changes.
The time and date display setting determines how time stamps are
formatted.

Date & time

Customize editable user interface texts, such as the drive name.Edit texts

Set backlight power save on/off and adjust display contrast and bright-
ness.

Display settings

Reset settings to their default values.Reset to defaults

Erase fault log: This functionality is available in a future release.
Reset Home view layout: Default Home view settings are restored.

Reset all parameters: This functionality is available in a future release.

Show or hide the numeric IDs of:Show in lists

• parameters and groups
• option list items
• bits
• devices in Options→ Select drive.
Enter pass codes into this parameter to activate further access levels
(for example, additional parameters).

Pass code

Primary settings
The Primary settingsmenu has the following sub-menus.

Note: The contents displayed may vary based on the drive/device to which the
control panel is connected. The menu shown is only an example.
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FunctionSub-menu

Set up drive control and the reference source by selecting from a set of
predefined wiring configurations.

Macro

Adjust drive related settings, such as control location, run permissions,
ramps, limits, constants speeds, flying starts references.

Drive

Adjust motor-related settings, such as control mode, nominal values, ID
run or thermal protection. Note that the settings that are visible depend
on other selections, for example, vector or scalar control mode, used
motor type or selected start mode.

Motor

Set up loop controller settings and actual values. The loop controller is
only used in remote control.

Loop controller

Controls onemotor connected to the drive and up to 3 auxiliary motors.Pump and fan
control

Use the drive with a fieldbus.Communication

Set up start/stop commands, reference, and related features, such as
constant speeds or run permissions.

Start, stop, refer-
ence

Set up acceleration and deceleration settings.Ramps

Set the permitted operating range. This function is intended to protect
the motor, connected hardware and mechanics. The drive stays within
these limits, no matter what reference value it gets.

Limits

Set up the settings and actual values for the process PID controller. PID
is only used in remote control.

PID

Set up the settings of Fieldbus communication.Fieldbus

Contains settings for advanced functions, such as triggeringor resetting
faults through I/O, or switching between entire sets of settings.

Advanced op-
tions/functions

Contains settings for language, date and time, display (such as bright-
ness) and settings to change how information is shown on the display.

Clock, region,
display

Here you can reset the Home view to its original factory state.Reset to defaults
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I/O
In the I/Omenu, each row provides terminal name, number, electrical status and
logical meaning of the drive. Each row also provides a sub-menu with more
information on the menu item and allow you to make changes to the I/O
connections.
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Diagnostics
TheDiagnosticsmenuprovidesdiagnostic information, suchas faultsandwarnings
and helps you to resolve potential problems. Use the menu to make sure that the
drive setup is functioning correctly.

Note: The contents displayed may vary based on the drive/device to which the
control panel is connected, and the menu shown is only an example.

FunctionSub-menu

Shows where the drive is currently taking its start, stop commands and
reference. The view updates in real time. If the drive does not start or
stop as expected, or runs at undesired speed, use this view to find out
where the control comes from.

Start, stop, refer-
ence, summary

Describes current operating limits. If the drive is running at undesired
speed, use this view to find out if any limitations are active.

Limit status

Shows the currently active faults and provides instructions on how to fix
and reset.

Active faults

Shows the currently active warnings and provides instructions on how
to fix and reset.

Active warnings

Shows the currently active inhibits. The drive cannot start. The drive is
not parameterized correctly.

Active inhibits

Lists the faults, warnings and other events that have occurred in the
drive.

Fault & event log

Provides status information and sent and receiveddata fromthe fieldbus
for troubleshooting.

Fieldbus

Provides status information of load distribution (that is, drive running
time spent on each load level) and peak load levels.

Load profile
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Functions in theOptionsmenu

What this chapter contains
This chapter describes functions in the Optionsmenu.

Options menu
In the Optionsmenu, you can control the settings related to the Home view.

Note: The contents displayed may vary based on the drive/device to which the
control panel is connected.

The menu shown is only an example.

The Optionsmenu has the following sub-menus:

FunctionSub-menu

Set the reference value with and . The changes occur when you save

them with a key press . Refer to Setting the reference (page 62).

Reference

6
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FunctionSub-menu

Change the direction of the motor rotation in local control mode.Direction change

Enable or disable the panel bus. If it is enabled, view the status of drives
in the panel bus and select which drive to control with the control panel.

Select drive

Refer to Control of multiple drives (page 67).

Edit the contents of theHome view. Refer to Editing the contents of the
Home view (page 62)..

Edit Home view

View active faults. Refer to Fault tracing (page 71).Active faults

View active warnings. Refer to Fault tracing (page 71).Active warnings

Setting the reference
You can change the reference when the drive is in the local control mode. You can
also change the reference in remote controlmode if thedrive configurationpermits
it. Changes take effect when saved with a key press.

1. Press key to switch to the local control mode, if the text in the top left
corner of the display reads Remote.

2. In the Optionsmenu, select Reference.

3. Change the reference:
• Use or to select a digit to edit.
• Use and to change the value of the selected digit.

4. Press (Save) to save the reference value, or (Cancel) to discard the
changes. The control panel returns to the Home view.

Tip: To adjust the reference from the Home view, press or and the reference
changes immediately. The reference value is highlighted during the change. If you
hold down the arrow key, the rate at which the value changes accelerates.

60.0
1200.0 rpm

Editing the contents of the Home view
1. In theOptionsmenu, select Edit Home view. The Home view opens in editing

mode.

2. In the editing mode, you can add, edit and delete the displayed parameters.

62 Functions in the Options menu



After editing the contents, press (Done) to confirm the changes and to exit
the editing mode and return to the Home view.

Softkey labels
and a blinking
cursor indicate
that the control
panel is in
editing mode.

Two-signal page in editing mode Empty page in editing mode

3. In the editing mode, use and to move between the different pages of the
Home view.
• To add a new page, navigate to the page that reads Press Add to make a

new screen.
• To edit, add or delete parameters on an existing page, navigate to that

page.

4. Use and to move the cursor highlight.
• To add a new parameter to an existing page, highlight an area above,

between or below an existing parameter.
• To edit or remove an existing parameter, highlight that parameter.

5. Press (Edit) to open the Display Slotmenu.

6. Choose a parameter, its display settings and scaling.
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Note: Parameters whose values have textual representations (such as the
names of bit states) or contain characters other than numbers (such as dates
or durations) are automatically shown as text. For these parameters, Display
style and the selections for numeric parameters are not available.

• Parameter: Select the parameter to show in the selected slot. The most
commonly used parameters are listed as presets.
For bit field parameters, you can select either a single bit or the full bit
field to add to the Home view. With individual bits, the bit state is shown.
Full bit fields are shown in either hexadecimal or binary format.

Note: If Empty is selected, the parameter is removed from theHome view.
• Display style: Select how the signal values are shown. It is possible to use

different display types on the same page.
• Numeric: Theparameter values are shownasnumbers (figure 1 below).

If there is only one parameter on the page, there is also a bar graph.
• Gauge/bar: When there is one parameter on the page, the parameter

value is shown as a dial gauge (figure 3 below). When there are two or
three parameters on the same page, the value is shown as a bar graph
(slots in figure 2 below).

• Graph 15minutes, 30minutes, 1 hour or 24 hours: The parameter value
is shown as a graph within the selected time frame (bottom slot in
figure 2).

2 31

Note: The data shown in the graph is not stored in the drivememory, that
is, if you remove or restart the control panel, the data is lost.

• Display decimals: Specifies howmany decimals are shown.
• Display name: Enter a custom label to show in the Home view instead of

the parameter name.
• Min and Max: This function depends on whether Scale value range is

selected or not:
• Scale value range not selected: Select the minimum and maximum

signal values that are shown on graph displays.
• Scale value range selected: Select the actual values of the parameter

that correspond to Display min as and Display max as (see below).
• Scale value range: Select if you want to specify the value range.

• Displaymin as andDisplaymaxas: Select theminimumandmaximum
values shown in the Home view.
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This feature permits application-specific scaling.
If the parameter value is below the minimum or above the maximum,
the text Off the scale is shown. In the graph format, small arrows are
shown instead to indicate values off the scale.
Scaling with Display signal min/max as and Signal min/max

Display signal min as Display signal max as

-50.00 display value 100.00

actual min
-32767

actual max
32768

actual value

Signal min
-3000

Signal max
6000

• Display unit: Customize the unit shown in Home view when scaling is
used.
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Control of multiple drives

What this chapter contains
This chapter describes how to control several drives with one control panel.

Connecting multiple drives to a control panel
1. Connect the control panel (A) to the first drive (B) in the panel bus.

2. Connect the first drive (C) to the second (D), the second to the third, and so
on, by daisy chaining RJ-45 leads.

Note: Each drive must have a node ID set with drive parameter 49.01 Node ID
number.

A

B C D

7
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The picture shows a panel bus example with ACS880-01 drives. The ACX580 and
ACX480 drives have dedicated panel bus adapters with two RJ-45 slots.

Selecting drive menu
In theOptionsmenu, select Select drivewhich lists all the drives connected to the
panel bus and shows their current status. If the panel bus is not enabled, only one
drive is shown.

In the panel bus, if the connection to the currently selected drive fails, the Select
drivemenu is shown with the other drive list.

In the Select drivemenu, any drives to which the connection is lost are shown in
dimmed text.

￭ Selecting a drive

If there aremultiple drives connected to the same panel bus, you can select which
drive to control with the control panel.

1. In the Optionsmenu, select Select drive to open a list of connected drives.

2. Use and tomove the cursor. When a drive is highlighted, the green LED on
the control panel blinks for one second.

3. Press (Select) to change control to the highlighted drive.

4. To refresh the drive list on the panel bus, press (Select) when Drive list
clean-up is highlighted.
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Control panel features with multiple drives

￭ Control panel views

In a panel bus configuration, the control panel communicates with one drive at a
time. The information on the control panel, such as the status bar or signals in the
Home view are for the currently selected drive. Similarly, the control panel stores
data to its memory only from the currently selected drive.

Changes to the Home view configuration and any parameter changes are saved
in the drive. They can be transferred to other drives using the backup feature.

You can view information on other drives in the panel bus and switch to another
drive in the Select drivemenu.

￭ The Help page

The content of the Help page is drive-specific, and it always refers to the currently
selected drive.

￭ Graph data

The data for the graph format in theHome view is stored in the control panel only
for the selected drive. If you change the selected drive, any stored graph data is
discarded, and graph data collection begins for the new drive.

History graphs and all related settings (signal selection, horizontal timescale) are
saved in thedrive, and theHistorygraphsmenu shows thegraphs for the currently
selected drive. Data collection takes places independently in each drive.

￭ Backups

The control panel can store backups from different drives. Conversely, backups
from a drive can be uploaded to another drive.

￭ Customized content

Each drive in the panel bus has its own custom content because all the
customizations are stored in the drive.

￭ Assistants

Assistants are drive-specific, which means that different drives in the panel bus
can have different assistants. However, the assistant framework is the same for
all assistants in all drives.
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Faults and warnings with multiple drives

￭ Faults and warnings in the currently selected drive

Faults and warnings in the currently selected drive are shown as normal.

￭ Faults and warnings in other drives

Faults in the other drives in the panel bus appear as remote faults.

Faults that require a restart look like any other remote faults. They are shown
normally if you switch to the drive in which the fault has occurred.

In the Fault view, the keys have the following functions:

• Press (Hide), to go back to the previous view. The fault view does not
reappear as with regular faults.

• Press (Switch,) to connect to the faulted drive.

Thecontrol panel showsonly activewarnings in theselecteddrive. Toviewwarnings
in another drive, you can select that drive in the Select drivemenu.
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Fault tracing

What this chapter contains
This chapter describes how to identify different fault and warning messages on
the control panel and how to solve problem situations.

Identifying error and warning messages
Faults and warnings are drive states that occur when the drive detects a problem
in its operation. The display message, backlight and LED indications help you to
identify the problem.

Some of the fault and warning icons and their descriptions are mentioned below.

IconEvent

Fault activate

Fault reset

Warning activate

Warning deactivate

Pure event activate

Pure event deactivate

Refer to the table below to identify faults and warnings.

8
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TypeLEDDisplay

Refer to Faults (page 73).continuous red

Faults of this type require stopping and
restarting the drive before it continues
to operate normally.

Refer to Faults (page 73).

blinking red

A fault has occurred in another drive in
the panel bus.

continuous red

Refer to Warnings (page 73).blinking green

Theconnectionbetween thecontrol panel
and the drive is faulty.

continuousgreen

Make sure that the connection cable is
connected correctly.

The control panel type is not compatible
with the drive you attempt to use it with.

continuousgreen

Refer to Applicability (page 12).

Theconnectionbetween thecontrol panel
and the drive was lost.

continuousgreen

The lost drive is shown as gray.

Check the control panel network connec-
tions.

Select another drive.
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TypeLEDDisplay

The Bluetooth connection between the
control panel and the drive was lost.

continuousgreen

The Bluetooth connection is shown as
gray.

Check the Bluetooth connection.

Faults
Faults are problems that require your attention before you start the drive again.

Do the following steps to solve the fault situation:

1. Identify and eliminate the cause of the fault. In the Fault view, you can see the
fault code. Refer to the relevant firmwaremanual formore information on the
fault.

2. Press (Reset) in the Fault view to reset the fault.

In the Fault view, the soft keys have the following functions:

• Press (Hide) or any of the arrow keys to temporarily hide the fault and go
back to the previous view. If there is also an activewarning, it is shown instead.
The fault view reappears after 60 seconds if no keys are pressed.

• Press (Reset) to reset the fault and return to the previous view.

•
Press the (? ) key to open the context-sensitive help. The help page has a
shortcut to the Fault Diagnostics Assistant which helps you solve the fault
situation.

Warnings
Warnings mean that a possible problem was detected and may need attention,
and the drive can still run. A warningmessage disappears once the condition that
triggered it goes away.

• Press (Hide) to hide the warning message and go back to the previous
view.
If the warning is still active after 60 seconds of no key presses, theWarning
view reappears automatically.

•
Press the (? ) key to open the context-sensitive help.

Note: Ifmultiplewarnings are active, the total number of activewarnings is shown.
Use and to scroll through the warnings.
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Maintenance

What this chapter contains
This chapter describes the service andmaintenance tasks of the assistant control
panel.

9
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Removing the control panel cover
You can remove the control panel cover to clean any dust inside the cover or to
change the cover to customize the control panel.

The cover consists of two parts, both of which can be removed. You do not need
tools to remove the covers.

1. Open the USB connector cover.

2. Remove the lower part of the control panel cover.

3. Remove the upper part of the cover.

Reinstall the covers in the reverse order.

3

1

2

Cleaning the control panel
Do not use harsh cleaners to prevent damage to the display window.

Cleaning the connectors
The control panel has two connectors, RJ45 connector (panel back side) and USB
connector (panel front side). Clean outside/around the connectors with suitable
cleaning solution (for example, Isopropyl Alcohol (IPA) solution). Do not use the
cleaning solution to clean inside the connectors.
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Replacing the control panel battery
The instructions below describe how to replace the battery that powers the
real-time clock of the control panel.

1. Turn the lid on the back of the control panel counter-clockwise until the lid
opens.

2. Remove the battery carefully.

3. Replace the battery with a new CR2032 battery. The battery holder has grip
nails.
First slide the battery and then press on the other side. The battery snaps in.

4. Make sure that the battery polarity shows positive on the upside.

5. Put the lid back and turn it clockwise to lock it.

6. Dispose of the old battery according to local disposal rules or applicable laws.

Note:For ZCU-12 (Supply control unit) battery replacement, contact your local ABB
representative.

Control panel software updates
If the control panel software needs to be updated, contact your local ABB
representative.

Recycling instructions and environmental information
Refer to the drive related Recycling instructions and environmental information.
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External connections

What this chapter contains
This chapter describes the USB and Bluetooth connection between the assistant
control panel and a PC.

USB connection
The three main functions of the USB connection:

• The control panel acts as anUSBadapter, allowing theDriveComposer PC tool
to communicatewith thedrive. Refer toConnectingaPC tool to adrive through
the control panel.

• It is possible to transfer data (for example, screenshots andbackups) between
the control panel and the PC with the Media Transfer Protocol (MTP) device.

• The USB port is intended for temporary service.

WARNING!
Use the USB connector carefully. Otherwise the connector may break.

Pull the USB connector cable correctly. Avoid pulling the cable in side ways
direction.
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￭ Connecting control panel to PC USB

Note:When connected to a PC, the control panel displays theUSB screen anddoes
not respond to key presses. In this mode, you can only interact with the control
panel or the drive through the Drive Composer PC tool.

To connect the control panel to a PC,

1. Open the lid of the USB connector.

2. Plug in a USB cable.

3. Connect the USB cable to a PC.
The control panel displays the USB screen.

The USB connector lid is attached to the control panel through a loose rubber
band. You can always connect the lid to the band, if it disconnects accidentally.

1

2

Rubber band

USB connected
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￭ Connecting Drive Composer PC tool to a drive through the control
panel

You can use the control panel to connect an ABB Drive Composer PC tool to the
drive. When using the control panel, you can only access the drive from the Drive
Composer PC tool.

1. Install an ABB Drive Composer PC tool to the PC.

2. Connect the control panel to the drive.

3. Connect the control panel to the PC with a USB cable as shown in Connecting
control panel to PC USB.

If Windows prompts you to install USB drivers, install them as shown in Drive
composer user’s manual (3AUA0000094606 [English]).

The behavior depends on the current control location of the drive. Refer to
Connecting in local control mode and Connecting in remote control mode.

Connecting in local control mode

1. Connect the control panel to a drive in the local control mode.

2. Connect the control panel to a PC with a USB cable. The control panel shows
the USB screen.

3. Start theDrive Composer PC tool and click Connect. The drive keeps its preset
reference and direction.

4. To disconnect the Drive Composer PC tool, go to Drive Composer PC tool File
-> Exit, and disconnect the USB cable.

The local control is transferred back to the control panel and keeps its present
reference and direction.

Note: Do not disconnect the USB cable before closing the PC tool.

Connecting in remote control mode

1. Connect the control panel to a drive in the remote control mode.

2. Connect the control panel to a PC with a USB cable. The control panel shows
the USB screen.

3. Start theDrive Composer PC tool and click Connect. You can only interactwith
the control panel through the Drive Composer PC tool. The drive remains in
remote control, but you can switch over to local control with the Drive
Composer PC tool.

4. To disconnect the Drive Composer PC tool, go to Drive Composer PC tool File
-> Exit, and disconnect theUSB cable. The drive resumes its normal operation.
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￭ Transferring files between the control panel and a PC

1. Connect the control panel to a PC with a USB cable as shown in Connecting
control panel to PC USB.

2. If Windows prompts you to install USB drivers, install them as ishown in Drive
composer user’s manual (3AUA0000094606 [English]).
The control panel appears as an MTP device in Windows Explorer.

3. Open ABB Drives Assistant control panelwith Windows Explorer, and go to
the directory where the files are stored.
• Screenshots are stored in: ABB Drives Assistant control panel\ABB Drives

Assistant control panel_a\screen
• Backup files are stored in: ABB Drives Assistant control panel\ABB Drives

Assistant control panel_a\backup

4. You can copy files to and from the folders just like any other fileswithWindows
Explorer.

Bluetooth connection
The two main functions of the Bluetooth connection:

• Connect the control panel toDrivetune via Bluetooth to communicatewith the
drive. Refer to Connecting control panel to Drivetune via Bluetooth.

• Connect the control panel to Drive Composer via Bluetooth to communicate
with the drive. Refer to Connecting control panel to Drive Composer via
Bluetooth.

￭ ConnectingDrivetune toadrive throughBluetoothon the control panel

Installing Drivetune app on Android device

To install the Drivetune app on your Android device, do the following steps:

1. On your Android device, openGoogle Play Store and search forDrivetune app.

2. Tap INSTALL against the Drivetune app and follow the instructions on your
screen. Wait for the installation to complete.

3. Tap OPEN, to open the app.

Note: For Chinese Android customers, you can download Drivetune app fromABB
official website, Yingyongbao store and app stores of your mobile phone.

Installing Drivetune app on iOS device

To install the Drivetune mobile app on your iOS device, do the following steps:

1. On your iOS device, open App Store and search for Drivetune app.
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2. Tap INSTALL against the Drivetune app and follow the instructions on your
screen.

3. Tap OPEN, to open the app.

Pairing the drive via Drivetune

1. On your mobile device, open Drivetune app.

2. Tap Pair to drive.

3. If the Bluetooth connection is not on, themessage "TurnOnBluetooth toAllow
"Drivetune" to Connect to Accessories" appears. Tap Settings to turn on
Bluetooth.
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4. Follow the instructions displayed on themobile screen and select a drive from
the device list.
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5. On the Bluetooth Assistant control panel, press and hold the ? button for two
seconds to make it discoverable.
• A blinking Blue LED indicates that Bluetooth is turned on.
• The control panel displays a PIN.

Functions in the main Menu   41

History graphs

The History graphs menu contains Trends and 
Load profile sub-menu.

 Trends

This functionality is available in a future release.

 Load profile

In the Load profile submenu, you can view and 
configure load profiles. The menu contains the 
following sub-menus:

• Amplitude logger 1: Opens a Histogram view, 
which displays the motor current as a 
distribution histogram. This logger cannot be 
reset.

• Amplitude logger 2: Opens a Histogram view, 
which displays the contents of an amplitude 
logger as a distribution histogram. You can 
select the signal to be monitored.

• Load profile configuration: Select the signal 
to be monitored in Amplitude logger 2.

• Peak value logger: Select a signal to be 
monitored by a peak value logger.

For more information on load profiles, see the appropriate firmware manual.

Backups

In the Backups menu, you can save parameter 
settings in the control panel memory and restore 
parameter settings from a backup to the drive. You 
can store up to two backup files on the control 
panel.

The assistant panel has a dedicated space for one 
automatic backup. An automatic backup is created 
two hours after the last parameter change. After completing the backup, the panel 
waits for 24 hours before checking if there are additional parameter changes. If there 
are, it creates a new backup overwriting the previous one. 

You can copy backup files to and from a PC with any file manager application 
(example, Windows Explorer).

• Enter the PIN when your mobile prompts for Bluetooth connection. Tap
Pair to connect to the drive.
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• Drive is paired with Drivetune app and ready for remote access.

Functions in the main Menu   41

History graphs

The History graphs menu contains Trends and 
Load profile sub-menu.

 Trends

This functionality is available in a future release.

 Load profile

In the Load profile submenu, you can view and 
configure load profiles. The menu contains the 
following sub-menus:

• Amplitude logger 1: Opens a Histogram view, 
which displays the motor current as a 
distribution histogram. This logger cannot be 
reset.

• Amplitude logger 2: Opens a Histogram view, 
which displays the contents of an amplitude 
logger as a distribution histogram. You can 
select the signal to be monitored.

• Load profile configuration: Select the signal 
to be monitored in Amplitude logger 2.

• Peak value logger: Select a signal to be 
monitored by a peak value logger.

For more information on load profiles, see the appropriate firmware manual.

Backups

In the Backups menu, you can save parameter 
settings in the control panel memory and restore 
parameter settings from a backup to the drive. You 
can store up to two backup files on the control 
panel.

The assistant panel has a dedicated space for one 
automatic backup. An automatic backup is created 
two hours after the last parameter change. After completing the backup, the panel 
waits for 24 hours before checking if there are additional parameter changes. If there 
are, it creates a new backup overwriting the previous one. 

You can copy backup files to and from a PC with any file manager application 
(example, Windows Explorer).

• Press Disconnect on the control panel to disconnect the drive.

Note: It is notpossible tohaveanactive connection tobothDriveComposer
PC tool and Drivetune at the same time.
• If you attempt to connect a drive paired to Drivetune to the Drive

ComposerPC tool,while aDrivetune session isongoing, the connection
to the mobile device disconnects automatically, that is, the Drivetune
session is deactivated.

• If the connection between drive and Drive Composer PC tool is active,
the Bluetooth option is not available to pair the drive with Drivetune.
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￭ Connecting Drive Composer Entry to a drive through Bluetooth on the
control panel

Drive Composer Entry V2.8 and later versions support Bluetooth connection to a
drive. To establish a connectionbetweenDriveComposer anddrivewithBluetooth
connection,

1. Double-click Drive Composer entry and launch Drive Composer.

2. On the Bluetooth Assistant control panel, press and hold the ? button for two
seconds to make it discoverable.
• A blinking Blue LED indicates that Bluetooth is turned on.
• The control panel displays a PIN. Enter this PIN when your mobile device

prompts for Bluetooth connection.
• Tap Scan, to connect to the drive.
• Drive is paired with Drivetune app and ready for remote access.
•

Note: It is notpossible tohaveanactive connection tobothDriveComposer
PC tool and Mobile Connect at the same time.
• If you attempt to connect a drive paired to Drivetune to the Drive

Composer PC tool, while a Mobile Connect session is ongoing, the
connection to themobile device disconnects automatically, that is, the
Mobile Connect session is deactivated.

• If the connection between drive and Drive Composer PC tool is active,
the Bluetooth option is not available to pair the drive with Drivetune.

3. Click Bluetooth connection and from the Available Bluetooth devices, select
the drive.

4. Enter theBluetoothpairing code. For informationonpairingBluetoothof your
computer with the drive, click . To reload the drives, click .

5. Click Connect to connect to the drive. Click Demo or Offline if you want to
choose the demo or offline mode.

6. To disconnect any connected drive, navigate to the Drive list and click
Disconnect.
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Note:

• The status LED starts flickering in the control panel to indicate data transfer
between drive and PC. The LED keeps blinking as long as there is a Drive
Composer PC tool connected to the drive. The welcome dialog box is shown
on the screen indicating that the application is initialized.

• With first time connection, parameter texts are loaded from the drive and this
may take a few minutes depending on the drive type.
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Technical data

What this chapter contains
This chapter contains the technical details of the assistant control panel.

Connectors
The control panel has the following connectors:

PurposeConnector

Used for connecting the control panel to the drive.RJ-45 female connector

• Themaximumpermitted cable length is 100meters (328 ft.)
• On a panel bus, the combinedmaximum length of the panel

bus cables is 100 meters (328 ft.).
• The panel bus can have a maximum of 32 nodes.
Used for connecting panel to a PC. It is intended for temporary
service use (USB 2.0,MTPprotocol). Themaximumcable length
is 3 meters (9.8 ft.).

TypeBminiUSBconnector

Pin assignment of RJ-45 connector:
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RemarkDescriptionSignal namePIN

Female port on the backRS485 communicationdata(+)RS485+1

RS485 communication data(-)RS485-2

Not connectedNC3, 4

Reference potential groundGND5, 6, 7

DC power supply(from Drive)Vcc8

Power supply (from the drive):

DC +15V… +24V (±10%)Supply voltage

Max. 65mA, 24V DCSupply current

Display
The control panel has a monochrome, 240×160 pixel resolution LCD display with
adjustable backlight and display contrast.

Refer to Basic settings and assistants (page 36).

Battery
At an ambient temperature of 25 °C (77 °F), the change interval of the real-time
clock battery is approximately 10 years.

CR2032Battery type

Dimensions and weight

130 gWeight
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Height, width and depth
mm [in.]

Degrees of protection

IP55Degree of protection, attached to a drive

IP20Separately

IP20When control panels are connected in stand-alone to RJ-45 cable

IP20When control panels are connected with USB cable.

IP55Control panel mounted to DPMP-01

IP65Control panel mounted to DPMP-02 or 03

IP20When the control panel is not mounted to DPMP-01 or 02 or 03 holder

A control panelmounted to a drive provides the sameprotection class as the drive
unit. For more information, refer to the hardware manual of the drive product.

Materials

PC/ABSEnclosure

CardboardPackaging

PolycarbonateScreen

Do not dispose the control panel with municipal waste.Disposal

Obey the local regulations for disposal of electronic products.

Refer to the drive-specific recycling instructions and environ-
mental information.
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Environmental limits

TransportationStorageOperation

--4000 m (13123 ft.)Installation site altitude

-40 °C to +70 °C-40 °C to +70 °C-20 °C to +55 °CAir temperature

(-40 °F to 158 °F)(-40 °F to 158 °F)(-4 °F to 131 °F)

95% (non-condensing)Relative humidity

--25 °C to +70 °C-20 °C to +70 °CTemperature inside the
control panel (-13 °F to 158 °F)(-4 °F to 158 °F)

Note: The accuracy of the real-time clock can be affected at very high and very low
temperatures.

IEC compliance

TransportationOperation

3C3Contamination levels

(IEC 60721-3-3, IEC 60721-
3-2,

IEC 60721-1-3-1)

class 2M3 in acc. with61800-5-1 ed 2.Sinusoidal vibration

EN 60082-2-6EN 60082-2-6 test Fc (1g)

class 2M2 in acc. withclass 3M4 in acc. withShock

EN 60082-2-27EN 60062-2-27

-IEC-60068-2-32, drop heightFree fall

1 m. (3.3 ft.)

-IEC 61000-4-2, IEC 61000-4-3,EMC compliance

IEC 61000-4-4, IEC 61000-4-6(EN 61800-3: 2004 +A1:
2012)

LCD specifications

FSTN, negative transmissiveLCD type

-20 °C to +70 °C (-4 °F to 158 °F)Operating temperature

-40 °C to +80 °C (-40 °F to 176 °F)Storage temperature

-40 °C to +80 °C (-40 °F to 176 °F)Transportation temperat-
ure

IC UC1698UDriver
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CompliantROHS

± 0.2General tolerance

Note: The response time of LCD display is slow at/below 0 °C (32 °F).

Bluetooth interface

Bluetooth 4.0 Dual mode (smart ready),Bluetooth standard

Bluetooth classic,

Bluetooth LE (low energy)

Bluetooth® Qualified DesignCertification

Internal inverted-F on PCBAntenna type

2.4000...2.4835 GHzOperating frequency

Maximum 1.7 dBiAntenna gain

Bluetooth encryption

Bluetooth LE
(low energy)

Bluetooth classic

AESCustom algorithms based on:Encryption algorithm

• SAFER+ for keyderivation (calledE21 and
E22)

• authenticationasmessageauthentication
codes (called E1)

• payload data encryption (called E0)
AESE0, E1, E21, E22/ SAFER+Encryption protocol

SymmetricalType

128Key length

Key derivation, authentication and payload
data encryption

Function
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Bluetooth radio frequency exposure

￭ Bluetooth (BT)

Transmit
power
[dBm,conduc-
ted]

Power levelData rate
[Mbps]

ModulationFrequency
[MHz]

Operating
band
[GHz BT]

9.3Maximum1GFSK2400 to
2483.5

2.4

￭ Bluetooth Low Energy (BLE)

Transmit
power
[dBm,conduc-
ted]

Power levelData rate
[Mbps]

ModulationFrequency
[MHz]

Operating
band
[GHz BLE]

9.3Maximum1GFSK2400 to
2483.5

2.4

FCC and Industry Canada certifications
The following FCC and Industry Canada certifications compliance identification
numbers are valid for ACS-AP-W and ACH-AP-W panels and Bluetooth.

• FCC ID: 2AFNGAPWSERIES

• IC: 20555-APWSERIES

￭ FCC ID: 2AFNGAPWSERIES

The ACS-AP-W and ACH-AP-W wireless assistant control panels comply with part
15 of the FCC rules.

The operation is subject to the following two conditions:

1. The device may not cause harmful interference, and

2. The device must accept any interference received, including interference that
may cause undesired operation.

Note:Thewireless panels are tested and found to complywith the limits of aClass
A digital device, pursuant to part 15 of the FCC rules. These limits are designed to
provide reasonable protection against harmful interference when the panels are
operated in a commercial environment.
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Note: The wireless panels will generate, use, and radiate radio frequency energy.
If the panels are not installed and used in accordancewith the instructionmanual,
it may cause harmful interference to radio communications. Operation of these
panels in a residential area is likely to cause harmful interference inwhich the user
is required to correct the interference at his own expense.

Note:Modifications not expressly approved by ABB Oy could void the user's
authority to operate the wireless panels.

￭ IC: 20555-APWSERIES

The ACS-AP-W and ACH-AP-W wireless assistant control panels comply with RSS-
247, Issue 1, 2015-05. The operation is subject to the following two conditions:

1. The device may not cause interference, and

2. Thedevicemust accept any interference, including interference thatmay cause
undesired operation of the device.

ANATEL certification
ANATEL Identifiers are unique authorization numbers assigned by Brazil's Agency
of National Telecommunications. The certificationmake sure product quality and
authorize operation at given frequencies and power outputs compliant with
regulations of Brazil's Agency of National Telecommunications.

ANATEL ID for ACS-AP-W : 10784-23-02705.

CMIIT certification
The following China Radio Law (CMIIT) certification compliance identification
numbers are valid for ACS-AP-W and ACH-AP-W:

• CMIIT ID for ACS-AP-W: 2022DJ0727

• CMIIT ID for ACH-AP-W: 2022DJ0713

Markings
These markings are attached to the panels:

• ACS-AP-W and ACH-AP-W

Technical data 95



CE mark

Product complieswith the applicable EuropeanUnion legislation. For fulfilling
the requirements of Radio Equipment Directive (RED), refer to the additional
information concerning the control panel EMC and RF compliance:

• IEC/EN 62368-1:2014 + A11:2017
• EN 62311:2008
• ETSI EN 301 489-1
• ETSI EN 301 489-17
• IEC/EN 61000-6-2:2019
• ETSI EN 300 328

Electronic InformationProducts (EIP) symbol includinganEnvironmentFriendly
Use Period (EFUP).

Product is compliant with the People’s Republic of China Electronic Industry
Standard (SJ/T 11364-2014) about hazardous substances. The EFUP is 20
years. China RoHS II Declaration of Conformity is available from https://lib-
rary.abb.com.

KC mark

Product complies with Korean Registration of Broadcasting and Communic-
ations Equipment Clause 3, Article 58-2 of Radio Waves Act.

UKCA (UK Conformity Assessed) mark

Product complieswith the applicableUnitedKingdom’s legislation (Statutory
Instruments). Marking is required for products being placed on the market
in Great Britain (England, Wales and Scotland).

• ACS-AP-… and ACH-AP-…

CE mark

Product complieswith the applicable EuropeanUnion legislation. For fulfilling
the requirements of Radio Equipment Directive (RED), refer to the additional
information concerning the control panel EMC and RF compliance:

• IEC/EN 62368-1:2014 + A11:2017
• EN 62311:2008
• ETSI EN 301 489-1
• ETSI EN 301 489-17
• IEC/EN 61000-6-2:2019
• ETSI EN 300 328

Electronic InformationProducts (EIP) symbol includinganEnvironmentFriendly
Use Period (EFUP).

Product is compliant with the People’s Republic of China Electronic Industry
Standard (SJ/T 11364-2014) about hazardous substances. The EFUP is 20
years. China RoHS II Declaration of Conformity is available from https://lib-
rary.abb.com.
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UKCA (UK Conformity Assessed) mark

Product complieswith the applicableUnitedKingdom’s legislation (Statutory
Instruments). Marking is required for products being placed on the market
in Great Britain (England, Wales and Scotland).

Disclaimers

￭ Generic disclaimer

Themanufacturer shall have no obligation hereunder with respect to any product
which (I) hasbeen improperly repairedor altered; (II) hasbeen subjected tomisuse,
negligence or accident; (III) has been used in a manner contrary to the
Manufacturer's instructions; or (IV) has failed as a result of ordinarywear and tear.
Allmaterial in thismanual is subject to changewithout a further notice. Themanual
is intended as non-contractual document.

￭ Cyber security disclaimer

This product is designed tobe connected to and to communicate information and
data via a network interface. It is Customer's sole responsibility to provide and
continuously ensure a secure connection between the product and Customer
network or any other network (as the case may be). Customer shall establish and
maintain any appropriate measures (such as but not limited to the installation of
firewalls, application of authenticationmeasures, encryption of data, installation
of anti-virus programs, etc.) to protect the product, the network, its system and
the interface against any kind of security breaches, unauthorized access,
interference, intrusion, leakage and/or theft of data or information.

ABB and its affiliates are not liable for damages and/or losses related to such
security breaches, anyunauthorizedaccess, interference, intrusion, leakageand/or
theft of data or information.
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Further information
—

Product and service inquiries
Address any inquiries about theproduct to your local ABB representative, quoting
the type designation and serial number of the unit in question. A listing of ABB
sales, support and service contacts can be found by navigating to
www.abb.com/contact-centers.

Product training
For information on ABB product training, navigate to
new.abb.com/service/training.

Providing feedback on ABB manuals
Your comments on our manuals are welcome. Navigate to
forms.abb.com/form-26567.

Document library on the Internet
Youcan findmanuals andotherproductdocuments inPDF formaton the Internet
at www.abb.com/drives/documents.
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